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Keyboard shortcuts 
The shortcut keys described in this Help topic refer to the U.S. keyboard layout. Keys on 
other layouts may not correspond exactly to the keys on a U.S. keyboard. 

For keyboard shortcuts in which you press two or more keys simultaneously, the keys to 
press are separated by a plus sign (+) in Microsoft Word Help. For keyboard shortcuts in 
which you press one key immediately followed by another key, the keys to press are 
separated by a comma (,). 

To print this topic, press TAB to select Show All, press ENTER, and then press 
CTRL+P. 

Help task pane and Help window 

Using the Help task pane and Help window 

The Help task pane provides access to all Office Help content and appears as part of 
Microsoft Word. The Help window displays topics and other Help content and appears as 
a window next to, but separate from, Word. 

In the Help task pane 
F1  

Display the Help task pane.  
F6  

Switch between the Help task pane and Word.  
TAB  

Select the next item in the Help task pane.  
SHIFT+TAB  

Select the previous item in the Help task pane.  
ENTER  

Perform the action for the selected item.  
DOWN ARROW and UP ARROW  

In a table of contents, select the next and previous item, respectively.  
RIGHT ARROW and LEFT ARROW  

In a table of contents, expand and collapse the selected item, respectively.  
ALT+LEFT ARROW  

Move back to the previous task pane.  
ALT+RIGHT ARROW  

Move forward to the next task pane.  
CTRL+SPACEBAR  

Open the menu of task panes.  
CTRL+F1  
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Close and reopen the current task pane.  
RIGHT ARROW  

Expand a +/- list.  
LEFT ARROW  

Collapse a +/- list. 

In the Help window 
TAB  

Select the next hidden text or hyperlink, or Show All or Hide All at the top of a 
topic.  

SHIFT+TAB  
Select the previous hidden text or hyperlink, or the Browser View button at the 
top of a Microsoft Office Web site article.  

ENTER  
Perform the action for the selected Show All, Hide All, hidden text, or hyperlink.  

ALT+LEFT ARROW  
Move back to the previous Help topic.  

ALT+RIGHT ARROW  
Move forward to the next Help topic.  

CONTROL+P  
Print the current Help topic.  

UP ARROW AND DOWN ARROW  
Scroll small amounts up and down, respectively, within the currently displayed 
Help topic.  

PAGE UP AND PAGE DOWN  
Scroll larger amounts up and down, respectively, within the currently displayed 
Help topic.  

ALT+U  
Change the Help window from being separate from (untiled) to connected to 
(tiled) Word.  

SHIFT+F10  
Display a menu of commands for the Help window; requires that the Help 
window have active focus (click an item in the Help window). 

Menus, toolbars, task panes, and dialog boxes 

Access and use menus and toolbars 

F10 or ALT  
Select the menu bar (menu bar: The horizontal bar below the title bar that contains 
the names of menus. A menu bar can be the built-in menu bar or a custom menu 
bar.), or close an open menu and submenu at the same time.  

CTRL+TAB or CTRL+SHIFT+TAB  
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Select a task pane or toolbar after pressing F10 or ALT to select the menu bar. 
Pressing the keys repeatedly moves the focus among the open toolbars, menu 
bars, and task pane.  

TAB or SHIFT+TAB  
When a toolbar (toolbar: A bar with buttons and options that you use to carry out 
commands. To display a toolbar, click Customize on the Tools menu, and then 
click the Toolbars tab.) or menu bar is selected, select the next or previous button 
or menu.  

ENTER  
Open the selected menu, or perform the action for the selected button or 
command.  

SHIFT+F10  
Display the shortcut menu (shortcut menu: A menu that shows a list of commands 
relevant to a particular item. To display a shortcut menu, right-click an item or 
press SHIFT+F10.) for the selected item.  

ALT+SPACEBAR  
Display the title bar shortcut menu.  

DOWN ARROW or UP ARROW  
When a menu or submenu (submenu: A menu that appears when a user points to a 
command on a higher-level menu.) is open, select the next or previous command.  

LEFT ARROW or RIGHT ARROW  
Select the menu to the left or right. When a submenu is open, switch between the 
main menu and the submenu.  

HOME or END  
Select the first or last command on the menu or submenu.  

ESC  
Close an open menu. When a submenu is open, close only the submenu.  

SHIFT+DOWN ARROW  
Open the selected menu.  

CTRL+DOWN ARROW  
When a shortened menu is open, display the full set of commands.  

ALT+CTRL+= (equal sign)  
Add a toolbar button to a menu. When you type this shortcut key and then click a 
toolbar button, Microsoft Word adds the button to the appropriate menu. For 

example, click Bullets on the Formatting toolbar to add the Bullets 
command to the Format menu.  

ALT+CTRL+- (dash key)  
Remove a command from a menu. When you type this shortcut key and then 
select a menu command, the command is removed. You can add the menu 
command back to the menu if you change your mind.  

ALT+CTRL++ (plus key on numeric keypad)  
Customize the shortcut key for a menu command. When you type this shortcut 
key and then select a menu command, the Customize Keyboard dialog box 
opens so you can add, change, or remove the shortcut key.  
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Note  You can use the keyboard to select any menu command on the menu bar. Press 
ALT to select the menu bar. Press the letter that is underlined in the menu name that 
contains the command you want. In the menu that appears, press the letter underlined in 
the command name that you want. 

Access and use task panes 

CTRL+F1  
Open the task pane or hide the current task pane.  

F6  
Move to a task pane (task pane: A window within an Office application that 
provides commonly used commands. Its location and small size allow you to use 
these commands while still working on your files.) from another pane in the 
program window. (You may need to press F6 more than once.)  
Note     If pressing F6 doesn't display the task pane you want, try pressing ALT to 
place focus on the menu bar, and then pressing CTRL+TAB to move to the task 
pane. In addition, if you open a dialog box from the Reveal Formatting task 
pane, the focus may be in your document after you close the dialog box, rather 
than in the task pane. You can use F6 or CTRL+TAB to return to the task pane.  

CTRL+TAB  
When a menu or toolbar (toolbar: A bar with buttons and options that you use to 
carry out commands. To display a toolbar, click Customize on the Tools menu, 
and then click the Toolbars tab.) is active, move to a task pane. (You may need to 
press CTRL+TAB more than once.)  

CTRL+SPACEBAR  
Open the menu of task panes.  

ALT+HOME  
Go to the Getting Started task pane.  

ALT+LEFT ARROW  
Reverse the sequence of task panes you opened.  

ALT+RIGHT ARROW  
Repeat the sequence of task panes you opened.  

ESC  
Close a menu if one is currently open, or go back to the document.  

TAB or SHIFT+TAB  
When a task pane is active, select the next or previous option in the task pane.  

DOWN ARROW or UP ARROW  
Move among choices in a selected submenu; move among certain options in a 
group of options.  

SPACEBAR or ENTER  
Open the selected menu, or perform the action assigned to the selected button.  

SHIFT+F10  
Open a shortcut menu (shortcut menu: A menu that shows a list of commands 
relevant to a particular item. To display a shortcut menu, right-click an item or 
press SHIFT+F10.) in a document; open a drop-down menu for the selected 
gallery item.  
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HOME or END  
When a menu or submenu is visible, select the first or last command on the menu 
or submenu.  

PAGE UP or PAGE DOWN  
Scroll up or down in the selected gallery list.  

CTRL+RIGHT ARROW or CTRL+LEFT ARROW  
Expand or collapse a collapsible item in the gallery list.  

CTRL+HOME or CTRL+END  
Move to the top or bottom of the selected gallery list.  

Resize and move toolbars, menus, and task panes 

1. Press ALT to select the menu bar (menu bar: The horizontal bar below the title 
bar that contains the names of menus. A menu bar can be the built-in menu bar or 
a custom menu bar.).  

2. Press CTRL+TAB repeatedly to select a toolbar (toolbar: A bar with buttons and 
options that you use to carry out commands. To display a toolbar, click 
Customize on the Tools menu, and then click the Toolbars tab.) or the task 
pane (task pane: A window within an Office application that provides commonly 
used commands. Its location and small size allow you to use these commands 
while still working on your files.).  

3. Do one of the following:  

Resize a toolbar 

1. In the toolbar, press CTRL+SPACEBAR to display the Toolbar Options 
menu.  

2. Select the Size command, and then press ENTER.  
3. Use the arrow keys to resize the toolbar. Press CTRL+ the arrow keys to 

resize one pixel at a time.  

Move a toolbar 

4. In the toolbar, press CTRL+SPACEBAR to display the Toolbar Options 
menu.  

5. Select the Move command, and then press ENTER.  
6. Use the arrow keys to position the toolbar. Press CTRL+ the arrow keys to 

move one pixel at a time. To undock the toolbar, press DOWN ARROW 
repeatedly. To dock the toolbar vertically on the left or right side, press 
LEFT ARROW or RIGHT ARROW respectively when the toolbar is all 
the way to the left or right side.  

Resize a task pane 
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7. In the task pane, press CTRL+SPACEBAR to display a menu of 
additional commands.  

8. Use the DOWN ARROW key to select the Size command, and then press 
ENTER.  

9. Use the arrow keys to resize the task pane. Use CTRL+ the arrow keys to 
resize by one pixel at a time.  

Move a task pane 

10. In the task pane, press CTRL+SPACEBAR to display a menu of 
additional commands.  

11. Use the DOWN ARROW key to select the Move command, and then 
press ENTER.  

12. Use the arrow keys to position the task pane. Use CTRL+ the arrow keys 
to move one pixel at a time.  

Note   If you move the task pane up into the toolbars or down into the 
status bar, the pane attaches itself to the bars and reorients itself 
horizontally. To return the task pane to its vertical position, use the arrow 
keys to move it away from the bars. 

4. When you are finished moving or resizing, press ESC or ENTER.  

Use dialog boxes 

ALT+F6  
Move from an open dialog box back to the document for dialog boxes such as 
Find and Replace that support this behavior.  

TAB  
Move to the next option or option group.  

SHIFT+TAB  
Move to the previous option or option group.  

CTRL+TAB  
Switch to the next tab in a dialog box.  

CTRL+SHIFT+TAB  
Switch to the previous tab in a dialog box.  

Arrow keys  
Move between options in an open drop-down list, or between options in a group 
of options.  

SPACEBAR  
Perform the action assigned to the selected button; check or clear the selected 
check box.  

First letter of an option in a drop-down list  
Open the list if it is closed and move to that option in the list.  

ALT+ the letter underlined in an option  
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Select an option; select or clear a check box.  
ALT+DOWN ARROW  

Open a selected drop-down list.  
ESC  

Close a selected drop-down list; cancel a command and close a dialog box.  
ENTER  

Run the selected command.  

Use edit boxes within dialog boxes 

An edit box is a blank in which you type or paste an entry, such as your user name or the 
path (path: The route that the operating system uses to locate a folder or file; for example, 
C:\House finances\March.doc.) to a folder. 

HOME  
Move to the beginning of the entry.  

END  
Move to the end of the entry.  

LEFT ARROW or RIGHT ARROW  
Move one character to the left or right.  

CTRL+LEFT ARROW  
Move one word to the left.  

CTRL+RIGHT ARROW  
Move one word to the right.  

SHIFT+LEFT ARROW  
Select or unselect one character to the left.  

SHIFT+RIGHT ARROW  
Select or unselect one character to the right.  

CTRL+SHIFT+LEFT ARROW  
Select or unselect one word to the left.  

CTRL+SHIFT+RIGHT ARROW  
Select or unselect one word to the right.  

SHIFT+HOME  
Select from the insertion point to the beginning of the entry.  

SHIFT+END  
Select from the insertion point to the end of the entry.  

Use the Open, Save As, and Insert Picture dialog boxes 

CTRL+F12  
Display the Open dialog box.  

F12  
Display the Save As dialog box.  

ALT+1  
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Go to the previous folder ( ).  
ALT+2  

Open the folder up one level from the open folder (Up One Level button ).  
ALT+3  

Close the dialog box and open your World Wide Web (World Wide Web 
(WWW): The multimedia branch of the Internet that presents not only text, but 
also graphics, sound, and video. On the Web, users can easily jump from item to 
item, page to page, or site to site by using hyperlinks.) search page (Search the 

Web button ).  
ALT+4  

Delete the selected folder or file (Delete button ).  
ALT+5  

Create a new subfolder in the open folder (Create New Folder button ).  
ALT+6  

Switch between List, Details, Properties, Preview Thumbnails, Tiles, and 

Icons views (click the arrow next to Views ).  
ALT+7 or ALT+L  

Show the Tools menu (Tools button).  
SHIFT+F10  

Display a shortcut menu (shortcut menu: A menu that shows a list of commands 
relevant to a particular item. To display a shortcut menu, right-click an item or 
press SHIFT+F10.) for a selected item such as a folder or file.  

TAB  
Move between options or areas in the dialog box.  

F4 or ALT+I  
Open the Look in or Save in list.  

F5  
Update the files visible in the Open or Save As dialog box (File menu).  

Quick reference 

Common tasks done in a Microsoft Word document 

CTRL+SHIFT+SPACEBAR  
Create a nonbreaking space.  

CTRL+HYPHEN  
Create a nonbreaking hyphen.  

CTRL+B  
Make letters bold.  

CTRL+I  
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Make letters italic.  
CTRL+U  

Make letters underline.  
CTRL+SHIFT+<  

Decrease font size.  
CTRL+SHIFT+>  

Increase font size.  
CTRL+SPACEBAR  

Remove paragraph or character formatting.  
CTRL+C  

Copy the selected text or object.  
CTRL+X  

Cut the selected text or object.  
CTRL+V  

Paste text or an object.  
CTRL+Z  

Undo the last action.  
CTRL+Y  

Redo the last action.  

Language bar 

Speech and handwriting recognition 

Left ALT+SHIFT  
Switch between languages or keyboard layouts.  

+V  
Switch microphone on or off.  

+T  
Switch between Voice Command mode and Dictation mode.  

+C  
Display a list of correction alternatives.  

+H  
Turn handwriting on or off.  

ALT+~  
Turn Japanese Input Method Editor (IME) (IME: A program that enters East 
Asian text (Traditional Chinese, Simplified Chinese, Japanese, or Korean) into 
programs by converting keystrokes into complex East Asian characters. The IME 
is treated as an alternate type of keyboard layout.) on 101 keyboard on or off.  

Right ALT  
Turn Korean IME on 101 keyboard on or off.  

CTRL+SPACEBAR  
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Turn Chinese IME on 101 keyboard on or off.  

Notes 

•  You can set the key combination for switching between languages or keyboard 
layouts in the Advanced Key Setting dialog box. To open the Advanced Key 
Setting dialog box, right-click the Language bar, and then click Settings. Under 
Preferences, click Key Settings.  

•  The Windows logo key ( ) is available on the bottom row of keys on most 
keyboards.  

E-mail 

Sending e-mail messages 

Use the following keys (if you are e-mailing a document or a message) when the 
insertion point is in the e-mail header. To move the insertion point into the e-mail header, 
press SHIFT+TAB. 

ALT+S  
Send the active document (active document: The document in which you're 
working. Text you type or graphics you insert in Microsoft Word appear in the 
active document. The title bar of the active document is highlighted.) or message.  

CTRL+SHIFT+B  
Open the Address Book.  

ALT+K, CTRL+K  
When the insertion point is in the message header, check the names on the To, Cc, 
and Bcc lines against the Address Book.  

ALT+. (period)  
Open the Address Book in the To field.  

ALT+C  
When the insertion point is in the message header, open the Address Book in the 
Cc field.  

ALT+B  
If the Bcc field is visible, open the Address Book in the Bcc field. To display the 
Bcc field, open the Address Book for any field, and insert or type a name in the 
Bcc box.  

ALT+J  
Go to the Subject field.  

ALT+P  
Open the Microsoft Outlook Message Options dialog box.  

CTRL+SHIFT+G  
Create a message flag.  

TAB  
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When the insertion point is in the message header, move to the next box in the e-
mail header. When the last box in the e-mail header is active, TAB moves the 
insertion point to the body of the document or message.  

SHIFT+TAB  
Select the previous field or button in the e-mail header.  

CTRL+TAB  
When the insertion point is in the message header, select the Send button. You 
can then use the arrow keys to move to the other buttons. To perform the action 
for the selected button or command, press ENTER.  

Working with documents and Web pages 

Create, view, and save documents 

CTRL+N  
Create a new document of the same type as the current or most recent document.  

CTRL+O  
Open a document.  

CTRL+W  
Close a document.  

ALT+CTRL+S  
Split the document window.  

ALT+SHIFT+C  
Remove the document window split.  

CTRL+S  
Save a document.  

Find, replace, and browse through text 

CTRL+F  
Find text, formatting, and special items.  

ALT+CTRL+Y  
Repeat find (after closing Find and Replace window).  

CTRL+H  
Replace text, specific formatting, and special items.  

CTRL+G  
Go to a page, bookmark, footnote, table, comment, graphic, or other location.  

ALT+CTRL+Z  
Switch between documents or sections of a document, and between a document 
and an open e-mail message if you use Word as your e-mail editor.  

ALT+CTRL+HOME  
Open a list of browse options; use the arrow keys to select an option, and then 
press ENTER to browse through a document by using the selected option.  
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Undo and redo actions 

ESC  
Cancel an action.  

CTRL+Z  
Undo an action.  

CTRL+Y  
Redo or repeat an action.  

Switch to another view 

ALT+CTRL+P  
Switch to print layout view (print layout view: A view of a document or other 
object as it will appear when you print it. For example, items such as headers, 
footnotes, columns, and text boxes appear in their actual positions.).  

ALT+CTRL+O  
Switch to outline view (outline view: A view that shows the headings of a 
document indented to represent their level in the document's structure. You can 
also use outline view to work with master documents.).  

ALT+CTRL+N  
Switch to normal view (normal view: A view that shows text formatting and a 
simplified page layout. Normal view is convenient for most editing and 
formatting tasks.).  

ALT+R  
Switch to Reading View.  

CTRL+\  
Expand or collapse subdocuments in a master document.  

Outline view 

In outline view, press 

ALT+SHIFT+LEFT ARROW  
Promote a paragraph.  

ALT+SHIFT+RIGHT ARROW  
Demote a paragraph.  

CTRL+SHIFT+N  
Demote to body text.  

ALT+SHIFT+UP ARROW  
Move selected paragraphs up.  

ALT+SHIFT+DOWN ARROW  
Move selected paragraphs down.  

ALT+SHIFT+PLUS SIGN  
Expand text under a heading.  
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ALT+SHIFT+MINUS SIGN  
Collapse text under a heading.  

ALT+SHIFT+A  
Expand or collapse all text or headings.  

The slash (/) key on the numeric keypad  
Hide or display character formatting.  

ALT+SHIFT+L  
Show the first line of body text or all body text.  

ALT+SHIFT+1  
Show all headings with the Heading 1 style.  

ALT+SHIFT+n  
Show all headings up to Heading n.  

CTRL+TAB  
Insert a tab character.  

Printing and previewing documents 

CTRL+P  
Print a document.  

ALT+CTRL+I  
Switch in or out of print preview (print preview: A view of a document as it will 
appear when you print it.).  

Arrow keys  
Move around the preview page when zoomed in.  

PAGE UP or PAGE DOWN  
Move by one preview page when zoomed out.  

CTRL+HOME  
Move to the first preview page when zoomed out.  

CTRL+END  
Move to the last preview page when zoomed out.  

Reviewing documents 

ALT+CTRL+M  
Insert a comment (comment: A note or annotation that an author or reviewer adds 
to a document. Microsoft Word displays the comment in a balloon in the margin 
of the document or in the Reviewing Pane.).  

CTRL+SHIFT+E  
Turn track changes (tracked change: A mark that shows where a deletion, 
insertion, or other editing change has been made in a document.) on or off.  

ALT+SHIFT+C  
Close the Reviewing Pane if it is open.  

Reading layout view 
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HOME  
Go to beginning of document.  

END  
Go to end of document.  

Number, then ENTER  
Go to page number.  

CTRL+]  
Increase the size of selected text by one point.  

CTRL+[  
Decrease the size of selected text by one point.  

ESC  
Exit reading layout view.  

References, footnotes, and endnotes 

ALT+SHIFT+O  
Mark a table of contents entry.  

ALT+SHIFT+I  
Mark a table of authorities entry (citation).  

ALT+SHIFT+X  
Mark an index entry.  

ALT+CTRL+F  
Insert a footnote.  

ALT+CTRL+D  
Insert an endnote.  

Working with Web pages 

CTRL+K  
Insert a hyperlink (hyperlink: Colored and underlined text or a graphic that you 
click to go to a file, a location in a file, a Web page on the World Wide Web, or a 
Web page on an intranet. Hyperlinks can also go to newsgroups and to Gopher, 
Telnet, and FTP sites.).  

ALT+LEFT ARROW  
Go back one page.  

ALT+RIGHT ARROW  
Go forward one page.  

F9  
Refresh.  

Note  To use keys to go back or forward one page or to refresh a page, the Web toolbar 
must be showing. If the Web toolbar is not showing, press ALT, press V, press T, use the 
arrow keys to select Web, and then press ENTER. 
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Editing and moving text and graphics 

Delete text and graphics 

BACKSPACE  
Delete one character to the left.  

CTRL+BACKSPACE  
Delete one word to the left.  

DELETE  
Delete one character to the right.  

CTRL+DELETE  
Delete one word to the right.  

CTRL+X  
Cut selected text to the Office Clipboard.  

CTRL+Z  
Undo the last action.  

CTRL+F3  
Cut to the Spike (Spike: A special AutoText entry that stores multiple deletions. 
Microsoft Word appends one item to another until you paste the contents as a 
group in a new location in your document. You can also use the Microsoft Office 
Clipboard to get the same result.).  

Copy and move text and graphics 

CTRL+C  
Copy text or graphics.  

CTRL+C, CTRL+C  
Display the Office Clipboard.  

F2 (then move the insertion point and press ENTER)  
Move text or graphics.  

ALT+F3  
Create AutoText (AutoText: A storage location for text or graphics you want to 
use again, such as a standard contract clause or a long distribution list. Each 
selection of text or graphics is recorded as an AutoText entry and is assigned a 
unique name.).  

CTRL+V  
Paste the Office Clipboard contents.  

CTRL+SHIFT+F3  
Paste the Spike (Spike: A special AutoText entry that stores multiple deletions. 
Microsoft Word appends one item to another until you paste the contents as a 
group in a new location in your document. You can also use the Microsoft Office 
Clipboard to get the same result.) contents.  

ALT+SHIFT+R  
Copy the header or footer used in the previous section of the document.  
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Insert special characters 

CTRL+F9  
A field  

ENTER (after typing the first few characters of the AutoText entry name and when the 
ScreenTip appears)  

An AutoText (AutoText: A storage location for text or graphics you want to use 
again, such as a standard contract clause or a long distribution list. Each selection 
of text or graphics is recorded as an AutoText entry and is assigned a unique 
name.) entry  

SHIFT+ENTER  
A line break  

CTRL+ENTER  
A page break  

CTRL+SHIFT+ENTER  
A section break  

ALT+CTRL+MINUS SIGN  
An em dash  

CTRL+MINUS SIGN  
An en dash  

CTRL+HYPHEN  
An optional hyphen  

CTRL+SHIFT+HYPHEN  
A nonbreaking hyphen  

CTRL+SHIFT+SPACEBAR  
A nonbreaking space  

ALT+CTRL+C  
The copyright symbol  

ALT+CTRL+R  
The registered trademark symbol  

ALT+CTRL+T  
The trademark symbol  

ALT+CTRL+PERIOD  
An ellipsis  

CTRL+`, `  
A single opening quotation mark  

CTRL+', '  
A single closing quotation mark  

CTRL+`, SHIFT+'  
Double opening quotation marks  

CTRL+', SHIFT+'  
Double closing quotation marks 

Insert characters by using character codes 
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The character code, ALT+X  
The Unicode character for the specified Unicode (hexadecimal) character code. 

For example, to insert the euro currency symbol ( ), type 20AC, and then hold 
down the ALT key and press X.  

ALT+the character code (on the numeric keypad)  
The ANSI (ANSI character set: An 8-bit character set used by Microsoft 
Windows that allows you to represent up to 256 characters (0 through 255) by 
using your keyboard. The ASCII character set is a subset of the ANSI set.) 
character for the specified ANSI (decimal) character code. For example, to insert 
the euro currency symbol, hold down the ALT key and press 0128 on the numeric 
keypad. 

Select text and graphics 

Select text by holding down SHIFT and pressing the key that moves the insertion point. 

Select multiple areas that aren't next to each other 

After making your first selection, hold down CTRL, and then select any other items you 
want. 

Extend a selection 

F8  
Turn extend mode on.  

F8, and then press LEFT ARROW or RIGHT ARROW  
Select the nearest character.  

F8 (press once to select a word, twice to select a sentence, and so on)  
Increase the size of a selection.  

SHIFT+F8  
Reduce the size of a selection.  

ESC  
Turn extend mode off.  

SHIFT+RIGHT ARROW  
One character to the right  

SHIFT+LEFT ARROW  
One character to the left  

CTRL+SHIFT+RIGHT ARROW  
To the end of a word  

CTRL+SHIFT+LEFT ARROW  
To the beginning of a word  

SHIFT+END  
To the end of a line  
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SHIFT+HOME  
To the beginning of a line  

SHIFT+DOWN ARROW  
One line down  

SHIFT+UP ARROW  
One line up  

CTRL+SHIFT+DOWN ARROW  
To the end of a paragraph  

CTRL+SHIFT+UP ARROW  
To the beginning of a paragraph  

SHIFT+PAGE DOWN  
One screen down  

SHIFT+PAGE UP  
One screen up  

CTRL+SHIFT+HOME  
To the beginning of a document  

CTRL+SHIFT+END  
To the end of a document  

ALT+CTRL+SHIFT+PAGE DOWN  
To the end of a window  

CTRL+A  
To include the entire document  

CTRL+SHIFT+F8, and then use the arrow keys; press ESC to cancel selection mode  
A vertical block of text  

F8+arrow keys; press ESC to cancel selection mode  
To a specific location in a document  

Tip 

If you know the key combination to move the insertion point, you can generally select the 
text by using the same key combination while holding down SHIFT. For example, 
CTRL+RIGHT ARROW moves the insertion point to the next word, and 
CTRL+SHIFT+RIGHT ARROW selects the text from the insertion point to the 
beginning of the next word. 

Select text and graphics in a table 

TAB  
Select the next cell's contents.  

SHIFT+TAB  
Select the preceding cell's contents.  

Hold down SHIFT and press an arrow key repeatedly  
Extend a selection to adjacent cells.  

Click in the column's top or bottom cell. Hold down SHIFT and press the UP ARROW or 
DOWN ARROW key repeatedly  
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Select a column.  
CTRL+SHIFT+F8, and then use the arrow keys; press ESC to cancel selection mode  

Extend a selection (or block).  
SHIFT+F8  

Remove the selection.  
ALT+5 on the numeric keypad (with NUM LOCK off)  

Select an entire table.  

Move the insertion point 

LEFT ARROW  
One character to the left  

RIGHT ARROW  
One character to the right  

CTRL+LEFT ARROW  
One word to the left  

CTRL+RIGHT ARROW  
One word to the right  

CTRL+UP ARROW  
One paragraph up  

CTRL+DOWN ARROW  
One paragraph down  

SHIFT+TAB  
One cell to the left (in a table)  

TAB  
One cell to the right (in a table)  

UP ARROW  
Up one line  

DOWN ARROW  
Down one line  

END  
To the end of a line  

HOME  
To the beginning of a line  

ALT+CTRL+PAGE UP  
To the top of the window  

ALT+CTRL+PAGE DOWN  
To the end of the window  

PAGE UP  
Up one screen (scrolling)  

PAGE DOWN  
Down one screen (scrolling)  

CTRL+PAGE DOWN  
To the top of the next page  

CTRL+PAGE UP  
To the top of the previous page  
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CTRL+END  
To the end of a document  

CTRL+HOME  
To the beginning of a document  

SHIFT+F5  
To a previous revision  

SHIFT+F5  
After opening a document, to the location it was in when the document was last 
closed  

Move around in a table 

TAB  
Next cell in a row  

SHIFT+TAB  
Previous cell in a row  

ALT+HOME  
First cell in a row  

ALT+END  
Last cell in a row  

ALT+PAGE UP  
First cell in a column  

ALT+PAGE DOWN  
Last cell in a column  

UP ARROW  
Previous row  

DOWN ARROW  
Next row  

Insert paragraphs and tab characters in a table 

ENTER  
New paragraphs in a cell  

CTRL+TAB  
Tab characters in a cell  

Character and paragraph formatting 

Copy formatting 

CTRL+SHIFT+C  
Copy formatting from text.  

CTRL+SHIFT+V  
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Apply copied formatting to text.  

Change or resize the font 

CTRL+SHIFT+F  
Change the font.  

CTRL+SHIFT+P  
Change the font size.  

CTRL+SHIFT+>  
Increase the font size.  

CTRL+SHIFT+<  
Decrease the font size.  

CTRL+]  
Increase the font size by 1 point.  

CTRL+[  
Decrease the font size by 1 point.  

Apply character formats 

CTRL+D  
Change the formatting of characters (Font command, Format menu).  

SHIFT+F3  
Change the case of letters.  

CTRL+SHIFT+A  
Format letters as all capitals.  

CTRL+B  
Apply bold formatting.  

CTRL+U  
Apply an underline.  

CTRL+SHIFT+W  
Underline words but not spaces.  

CTRL+SHIFT+D  
Double-underline text.  

CTRL+SHIFT+H  
Apply hidden text formatting.  

CTRL+I  
Apply italic formatting.  

CTRL+SHIFT+K  
Format letters as small capitals.  

CTRL+EQUAL SIGN  
Apply subscript formatting (automatic spacing).  

CTRL+SHIFT+PLUS SIGN  
Apply superscript formatting (automatic spacing).  

CTRL+SPACEBAR  
Remove manual character formatting.  
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CTRL+SHIFT+Q  
Change the selection to the Symbol font.  

View and copy text formats 

CTRL+SHIFT+* (asterisk)  
Display nonprinting characters.  

SHIFT+F1 (then click the text whose formatting you want to review)  
Review text formatting.  

CTRL+SHIFT+C  
Copy formats.  

CTRL+SHIFT+V  
Paste formats.  

Set line spacing 

CTRL+1  
Single-space lines  

CTRL+2  
Double-space lines  

CTRL+5  
Set 1.5-line spacing  

CTRL+0 (zero)  
Add or remove one line space preceding a paragraph  

Align paragraphs 

CTRL+E  
Center a paragraph.  

CTRL+J  
Justify a paragraph.  

CTRL+L  
Left align a paragraph.  

CTRL+R  
Right align a paragraph.  

CTRL+M  
Indent a paragraph from the left.  

CTRL+SHIFT+M  
Remove a paragraph indent from the left.  

CTRL+T  
Create a hanging indent.  

CTRL+SHIFT+T  
Reduce a hanging indent.  

CTRL+Q  
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Remove paragraph formatting.  

Apply paragraph styles 

CTRL+SHIFT+S  
Apply a style.  

ALT+CTRL+K  
Start AutoFormat.  

CTRL+SHIFT+N  
Apply the Normal style.  

ALT+CTRL+1  
Apply the Heading 1 style.  

ALT+CTRL+2  
Apply the Heading 2 style.  

ALT+CTRL+3  
Apply the Heading 3 style.  

CTRL+SHIFT+L  
Apply the List style.  

Drawing objects and other objects 

Inserting and editing objects 

Insert an object by using the keyboard. 

1. Use the keyboard to open the Object dialog box (Insert menu).  
2. Use the DOWN ARROW key to select an object, and then tab to OK, and press 

ENTER. 

Edit an object by using the keyboard. 

1. With the insertion point to the left of the object in your document, select the 
object by pressing SHIFT+RIGHT ARROW.  

2. Press SHIFT+F10.  
3. Tab to Object name Object, press ENTER, and then press ENTER again. 

Inserting and selecting drawing objects 

Insert an AutoShape by using the keyboard. 

1. Use the keyboard to show the Drawing toolbar if it is not showing.  
2. Press ALT+U to choose AutoShape on the Drawing toolbar.  
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3. Use the arrow keys to move through the categories of AutoShapes (AutoText: A 
storage location for text or graphics you want to use again, such as a standard 
contract clause or a long distribution list. Each selection of text or graphics is 
recorded as an AutoText entry and is assigned a unique name.) and select the 
AutoShape you want.  

4. Press CTRL+ENTER.  

Note  To edit the AutoShape, select the AutoShape, and then use the keyboard to choose 
AutoShape on the Format menu. Select the options you want on the available tabs. 

Insert a text box by using the keyboard 

1. Use the keyboard to select Text Box on the Insert menu.  
2. Use the right arrow key to open the submenu, select either Horizontal or 

Vertical, and then press CTRL+ENTER.  
3. Type the text you want in the text box (text box: A movable, resizable container 

for text or graphics. Use text boxes to position several blocks of text on a page or 
to give text a different orientation from other text in the document.).  

4. When you are finished typing and want to switch back to editing text in your 
document, press SHIFT+F10, choose Exit Edit Text on the shortcut 
menu (shortcut menu: A menu that shows a list of commands relevant to a 
particular item. To display a shortcut menu, right-click an item or press 
SHIFT+F10.), and then press ESC.  

Note  To format the text box (add a fill color or change the size, for example), select the 
text box, choose Text Box on the Format menu, and then select the options you want on 
the available tabs. 

Insert a WordArt drawing object by using the keyboard 

1. Use the keyboard to choose WordArt (Insert menu, Picture submenu).  
2. Use the arrow keys to select the WordArt (WordArt: Text objects you create with 

ready-made effects to which you can apply additional formatting options.) style 
you want, and then press ENTER.  

3. Type the text you want, and then use the TAB key to select other options in the 
dialog box.  

4. Press ENTER to insert the WordArt drawing object (drawing object: Any graphic 
you draw or insert, which can be changed and enhanced. Drawing objects include 
AutoShapes, curves, lines, and WordArt.).  

Note  To edit the WordArt drawing object, select the object, choose WordArt on the 
Format menu, and then select the options you want on the available tabs. 

Select a drawing object by using the keyboard 
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If the insertion point is within text in your document, do the following: 

1. Press F10 to make the menu bar (menu bar: The horizontal bar below the title bar 
that contains the names of menus. A menu bar can be the built-in menu bar or a 
custom menu bar.) active.  

2. Press CTRL+TAB until the Drawing toolbar is active.  

3. Press the RIGHT ARROW key to choose Select Objects .  
4. Press CTRL+ENTER to select the first drawing object (drawing object: Any 

graphic you draw or insert, which can be changed and enhanced. Drawing objects 
include AutoShapes, curves, lines, and WordArt.).  

5. Press the TAB key to cycle forward (or SHIFT+TAB to cycle backward) through 
the objects until sizing handles appear on the object you want to select.  

If the insertion point is within text in a drawing object, do the following: 

1. Press SHIFT+F10, and then use the keyboard to choose Exit Edit Text on the 
shortcut menu.  

2. Press the TAB key to cycle forward (or SHIFT+TAB to cycle backward) through 
the objects until sizing handles appear on the object you want to select.  

Note  To switch from selecting objects back to editing text in your document, press ESC. 

Editing drawing objects 

Rotate a drawing object by using the keyboard 

1. Select the drawing object (drawing object: Any graphic you draw or insert, which 
can be changed and enhanced. Drawing objects include AutoShapes, curves, lines, 
and WordArt.) you want to rotate.  

2. Use the keyboard to choose the command for the type of object you selected— for 
example, on the Format menu, choose AutoShape or Text Box— and then select 
the Size tab.  

3. Under Size and rotate, use the TAB key to select Rotation, and then type the 
amount of rotation you want.  

Change the position of a drawing object on a page by using the keyboard 

1. Select the drawing object (drawing object: Any graphic you draw or insert, which 
can be changed and enhanced. Drawing objects include AutoShapes, curves, lines, 
and WordArt.) you want to change.  

2. Use the keyboard to choose the command for the type of object you selected— for 
example, on the Format menu, choose AutoShape or Text Box— and then select 
the Layout tab.  
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3. Select the options you want.  

Tip 

You can nudge the selected object up, down, left, or right by holding down CTRL and 
pressing arrow keys. 

Change the size of a drawing object by using the keyboard 

1. Select the drawing object (drawing object: Any graphic you draw or insert, which 
can be changed and enhanced. Drawing objects include AutoShapes, curves, lines, 
and WordArt.) you want to change.  

2. Use the keyboard to choose the command for the type of object you selected— for 
example, on the Format menu, choose AutoShape or Text Box— and then select 
the Size tab.  

3. Select the options you want.  

Copy the attributes of a drawing object by using the keyboard 

1. Select the drawing object (drawing object: Any graphic you draw or insert, which 
can be changed and enhanced. Drawing objects include AutoShapes, curves, lines, 
and WordArt.) with the attributes you want to copy.  

If you select an AutoShape (AutoShapes: A group of ready-made shapes that 
includes basic shapes, such as rectangles and circles, plus a variety of lines and 
connectors, block arrows, flowchart symbols, stars and banners, and callouts.) 
with attached text, you copy the look and style of the text as well as the attributes 
of the AutoShape. 

2. Press CTRL+SHIFT+C to copy the object attributes.  
3. Press the TAB key or SHIFT+TAB to select the object you want to copy the 

attributes to.  
4. Press CTRL+SHIFT+V.  

Mail merge and fields 

Performing a mail merge 

Note  You must start the Mail Merge task pane (Tools menu, Letters and Mailings 
command, Mail Merge subcommand) before you can use these commands. 

ALT+SHIFT+K  
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Preview a mail merge.  
ALT+SHIFT+N  

Merge a document.  
ALT+SHIFT+M  

Print the merged document.  
ALT+SHIFT+E  

Edit a mail-merge data document.  
ALT+SHIFT+F  

Insert a merge field.  

Working with fields 

ALT+SHIFT+D  
Insert a DATE field (field: A set of codes that instructs Microsoft Word to insert 
text, graphics, page numbers, and other material into a document automatically. 
For example, the DATE field inserts the current date.).  

ALT+CTRL+L  
Insert a LISTNUM field.  

ALT+SHIFT+P  
Insert a PAGE field.  

ALT+SHIFT+T  
Insert a TIME field.  

CTRL+F9  
Insert an empty field.  

CTRL+SHIFT+F7  
Update linked information in a Microsoft Word source document.  

F9  
Update selected fields.  

CTRL+SHIFT+F9  
Unlink a field.  

SHIFT+F9  
Switch between a selected field code (field code: Placeholder text that shows 
where specified information from your data source will appear; the elements in a 
field that generate a field's result. The field code includes the field characters, 
field type, and instructions.) and its result (field results: Text or graphics inserted 
in a document when Microsoft Word carries out a field's instructions. When you 
print the document or hide field codes, the field results replace the field codes.).  

ALT+F9  
Switch between all field codes and their results.  

ALT+SHIFT+F9  
Run GOTOBUTTON or MACROBUTTON from the field that displays the field 
results.  

F11  
Go to the next field.  

SHIFT+F11  
Go to the previous field.  
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CTRL+F11  
Lock a field.  

CTRL+SHIFT+F11  
Unlock a field.  

Key combinations 

Function keys 

F1  
Get Help or visit Microsoft Office Online.  

F2  
Move text or graphics.  

F3  
Insert an AutoText (AutoText: A storage location for text or graphics you want to 
use again, such as a standard contract clause or a long distribution list. Each 
selection of text or graphics is recorded as an AutoText entry and is assigned a 
unique name.) entry (after Microsoft Word displays the entry).  

F4  
Repeat the last action.  

F5  
Choose the Go To command (Edit menu).  

F6  
Go to the next pane or frame.  

F7  
Choose the Spelling command (Tools menu).  

F8  
Extend a selection.  

F9  
Update selected fields.  

F10  
Activate the menu bar.  

F11  
Go to the next field.  

F12  
Choose the Save As command (File menu).  

SHIFT+Function key 

SHIFT+F1  
Start context-sensitive Help or reveal formatting.  

SHIFT+F2  
Copy text.  

SHIFT+F3  
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Change the case of letters.  
SHIFT+F4  

Repeat a Find or Go To action.  
SHIFT+F5  

Move to the last change.  
SHIFT+F6  

Go to the previous pane or frame.  
SHIFT+F7  

Choose the Thesaurus command (Tools menu, Language submenu).  
SHIFT+F8  

Shrink a selection.  
SHIFT+F9  

Switch between a field code and its result.  
SHIFT+F10  

Display a shortcut menu.  
SHIFT+F11  

Go to the previous field.  
SHIFT+F12  

Choose the Save command (File menu).  

CTRL+Function key 

CTRL+F2  
Choose the Print Preview command (File menu).  

CTRL+F3  
Cut to the Spike (Spike: A special AutoText entry that stores multiple deletions. 
Microsoft Word appends one item to another until you paste the contents as a 
group in a new location in your document. You can also use the Microsoft Office 
Clipboard to get the same result.).  

CTRL+F4  
Close the window.  

CTRL+F5  
Restore the document window size (for example, after maximizing it).  

CTRL+F6  
Go to the next window.  

CTRL+F7  
Choose the Move command (title bar shortcut menu).  

CTRL+F8  
Choose the Size command (title bar shortcut menu).  

CTRL+F9  
Insert an empty field.  

CTRL+F10  
Maximize the document window.  

CTRL+F11  
Lock a field.  

CTRL+F12  
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Choose the Open command (File menu).  

CTRL+SHIFT+Function key 

CTRL+SHIFT+F3  
Insert the contents of the Spike (Spike: A special AutoText entry that stores 
multiple deletions. Microsoft Word appends one item to another until you paste 
the contents as a group in a new location in your document. You can also use the 
Microsoft Office Clipboard to get the same result.).  

CTRL+SHIFT+F5  
Edit a bookmark.  

CTRL+SHIFT+F6  
Go to the previous window.  

CTRL+SHIFT+F7  
Update linked information in a Microsoft Word source document.  

CTRL+SHIFT+F8  
Extend a selection or block (then press an arrow key).  

CTRL+SHIFT+F9  
Unlink a field.  

CTRL+SHIFT+F11  
Unlock a field.  

CTRL+SHIFT+F12  
Choose the Print command (File menu).  

ALT+Function key 

ALT+F1  
Go to the next field.  

ALT+F3  
Create an AutoText (AutoText: A storage location for text or graphics you want 
to use again, such as a standard contract clause or a long distribution list. Each 
selection of text or graphics is recorded as an AutoText entry and is assigned a 
unique name.) entry.  

ALT+F4  
Quit Microsoft Word.  

ALT+F5  
Restore the program window size.  

ALT+F6  
Move from an open dialog box back to the document for dialog boxes such as 
Find and Replace that support this behavior.  

ALT+F7  
Find the next misspelling or grammatical error. The Check spelling as you type 
check box must be selected (Tools menu, Options dialog box, Spelling & 
Grammar tab).  

ALT+F8  
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Run a macro.  
ALT+F9  

Switch between all field codes and their results.  
ALT+F10  

Maximize the program window.  
ALT+F11  

Display Microsoft Visual Basic code.  

ALT+SHIFT+Function key 

ALT+SHIFT+F1  
Go to the previous field.  

ALT+SHIFT+F2  
Choose the Save command (File menu).  

ALT+SHIFT+F9  
Run GOTOBUTTON or MACROBUTTON from the field that displays the field 
results.  

ALT+SHIFT+F10  
Display the menu or message for a smart tag. If more than one smart tag is 
present, switch to the next smart tag and display its menu or message.  

ALT+SHIFT+F11  
Start the Microsoft Script Editor.  

CTRL+ALT+Function key 

CTRL+ALT+F1  
Display Microsoft System Information.  

CTRL+ALT+F2  
Open command (File menu).  

 


